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Creating Content in Google Earth

Creating content in Google Earth enables a user to create personal Google Earth files. While this is not
exceptionally difficult, there are some specifics that you need to know.

Working with Placemarks

You can place more interesting information in Google Earth placemarks. Placemarks are the push-pins or other
icons that you click on when you are using Google Earth. When you click on a placemark it opens a placemark
window (a.k.a. - bubble), that displays the information that has been added to the placemark.
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Types of information that you can include in a placemark

+ Text

+ Images

« Hyperlinks — links to other web sites

+ Video (i.e. - YouTube)

« Other specialized web content (i.e. - PowerPoint files using Slideshare.net)



http://www.slideshare.net/
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Adding Your Content

Users can add text into a placemark by simply typing into the placemark, however, changing the font, color, size
of the text is not available in Google Earth (yet). So, adding formatted text and other content (see list above)

requires entering HTML code into the placemark window.
Because most users do not know how to write HTML code, we will use an online HTML editor to create the
code for inserting into our Google Earth placemarks. The purpose of using the HTML editor is:

« to create your content without having to know how to write HTML code
« to copy/paste the HTML code created for your content into your Google Earth placemark window

The online editor looks similar to a word processor and uses a similar WYSIWYG editor (pronounced wizzy
wig for What You See Is What You Get). Below is the link to the online HTML editor:

. HTML Editor — http://www.bnl.gov/itd/htmleditor

Add Text
To add the text, simply type in the editor window. Change the text as you would in word processing software
like Microsoft Word.

Information Technology Division

BHL: Departments | Science | ESS&H | Newsroom | Administration | Visitors | Directory

Online HTML Editor (v3.0.5)
ITD Home | Online Help & Documentation

this application will only be available to the Brookhaven National Laboratory user community.

Format text

YG editor is cross-browser compatible and will work with most popular internet browsers.
ude: IE, Firefox, Mozilla, SAfari, and Netscape.

This online HTML
Supported Browsers

Paragraph ~ Fontfamly - Fontsize

A-2-o | JERTy 3 NN (o
ﬂ HTML button |
| Type text here |

Path: p

Add a photo

Grabbing Your Code
After you have formatted your text above, press the (HTML) button located in the upper toolbar to convert and

view your text in raw HTML code (Text Mode). Select your text by pressing (CTRL-A). Once the text is highlighted,
copy & paste the HTML code into your application by pressing (CTRL-C) to copy and (CTRL-V) to paste.



http://www.bnl.gov/itd/htmleditor
http://www.bnl.gov/itd/htmleditor/
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Adding Images

To add an image, find an image online, get the URL (web address) of the image by right clicking and selecting
Properties, copy the address, click the image tool, and paste the address in.

NOTE: Keep in mind that you need to have permission to use photos that are not yours and credit should be
given by providing or linking the original owner or the location of the photo.

1. Find an image on the web and right-click and select Properties in Internet Explorer or Copy

Image Location in Firefox. If you are using Mozilla Firefox browser this is all you will need to
do, the Address (URL) is already copied. If using Internet Explorer proceed to step 2 below.

2. Copy the Address (URL)

& Erie Canal, Fairport on Flickr - Photo Sharing! - Windows Internet Explorer |EIM|
& () = [#® htepe//wwnw ficke.com/photos/15047T76@ N5 2315748068/ ~ [ ] #2 [ % || 2 Googie Powered Digsby searcn o+
i Fovorites |29+ | /€ Creating Con... gw Information ... ®® Erie Canal... | - ~ [Z] @ ~ Page~ Safety~ Tools~ @~ 0 Bf Bl @ <&
flickr Signed in as BrianCSmith %= & Help  Sign Out o
Home You Organize Contacts Groups Explore | Search
= P Properties =]
Erie Canal, Fairport
*‘ lis
General
Ano 12 sLoa AL
FrEs B ThiE Aites
@ 2318748068_0bB6e40593 jpg7v-0 3
Right-click the picture, tream -
- i
select Properties I -
Protocol: HyperText Transfer Protocol |
Type: JPG Fie I i
Address p.//farm3 static flickr.com/2231/2318748068_006 E
(URL) 62405593 jpgPv=0
138204 e to
333 pixels = -
(1
. . - -
Erie Canal at Fairport, looking west towards the Main Street i
Comments = oz
chocolatepoint pro says:
+
This looks like a fun place to hang out! Nice photo
Posted 15 months ago. ( permalink + 3
Seajays pre says: +
Hi, I'm an admin for a group called Mavigable Waterways (a pictorial quide), N y Poo
and we'd love to have this added to the group! Y e e e R e =
& €D Internet | Protected Mode: OFff 3 v ®10% -

3. Inthe HTML editor, click Insert/edit Image icon
4. Paste the copied picture Address (URL) into the Image URL box

5. Click Insert to add picture to the HTML editor
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utton located in the upper toolbar to convert and
o t by pressing (CTRL-A). Once the text is highlighted,
copy & paste the HTML code into your application by pressing (CTRL-C) to copy and (CTRL-V) to paste.

Converting HTML to Text

To Convert HTML to normal text format, press the (HTML) button located in the upper toolbar. Paste your raw HTML
code into the text area above, then press the (HTML) button (Text Mode) to convert the HTML code back to normal
tavt

€D Internet | Protected Mode: Off 4 v ®100% -

Adding Hyperlinks

Type the text you want to become the link, highlight it, and use the link tool in the tools menu, and then paste or
type the link (URL) in. Here is what it might look like:

1. Copy the web address from the site you want to link
2. Inthe HTML editor highlight the word or words you want to hyperlink
3. Click the Insert/edit link icon

4. Paste the web address in the Insert URL box in the window that appears

on Technology Division

BNL: Departments | Science | ESS&H | Newsroom | Administration | Visitors | Directory.

Online HTML Editor (v3.0.5) [ e
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ITD Home |

1. Copy web address you General properties
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This online f browser. b and wil wd| | | Tarset  [Openn this vindowy frame
Supported d Netscape., Title [ l. ]

Class -- Not set - ‘ :

Parsgraph  * Fontfamiy v Fontsize v Z U |[x x i l

A-2-(Gn o 440 % A= @0 0|~

3. Click Insert/edit 4. Paste web address in
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e
Grabbing Your Code |

After you have formatted your text above, press the (HTML) button located in the upper toolbar to convi
view your text in raw HTML code (Text Mode). Select your text by pressing (CTRL-A). Once the text is highligh Click Insert
copy & paste the HTML code into your application by pressing (CTRL-C) to copy and (CTRL-V) to paste.

Converting HTML to Text

To Convert HTML to normal text format, press the (HTML) button located in the upper toolbar. Paste your raw HTML
code into the text area above, then press the (HTML) button (Text Mode) to convert the HTML code back to normal
text.

Kevboard shortcuts

& Internet | Protected Mode: Off ¢y v H100%
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Adding Video Content

1. Go to the web site that contains the video you would like to add (i.e. - http://www.youtube.com)

2. Select the video you want
3. Highlight and copy the Embed code

4. Paste into the online editor, while in HTML mode (see below).

Yﬂll m Worldwide | English Sign Up | QuickList (0) | Help S\gn:

Home | Videos | Shows | Channels = Community erie canal Search Upload | w |

§| RocPicDotCom — ‘=
I December 26, 3
2006

Alugboat pushes a barge on the Erie Canal. Shotir|
the area where the Erie aka Barge Canal meets the|
Genesee Riverin Rochester NY

Tugboat On The Erie Canal Rochester NY

URL  hitp://www. youtube. comiwatch v=bRQhHS:

Embed <object width="425" hE\ghi:"344‘5<pavsm-E

After making your selection, copy
and paste the embed code above.
The code changes based an your
selection

Include related videos
[71 show Border
[E] Enable delayed cookies [7]

- ozio3s o (@ =0 9 | B R |

Y% % K &I 7 ratings 7,054 views

Favorite  + Share Playlists Flag

MySpace Facebook Twitter

} statistics & Data i

} Video Responses (0) Sign in to post a Video Response » More From: RocPicDotCom

R o e e e R e

4| n [3
€ Intemet | Protected Mode: OFf v 1% -

T

BNL: Departments | Science | ESS&H | Newsroom O SEIee E ¥ Word wrap

[nz><atzong><span style="font-size: small;">Video</apan></atrong></ha>
<p>anbspi</p>

[<object width=" height="344"><paren na:
[value="htep: / /. youtube.. com/ v/ bRQN
name="allowFull

Online HTML Editor (v3.0.5)

ITD Home | Online Help & Documentation pame-"allowscriptacoess” value="alvay:
Ctp: / /v youtube.. com/v/BRORHSS
‘type="appl asn" al "aluay

Note: Technical support for this application will only be available to the Brookhaven Nati{ | |211owfullscreen="crue” width="425" height="344"></enbed></object>

This online H

Supported B Click HTML button
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SAfari, and Netscape

Paragriaph |~ Fontfamiy - Fontsze - B 7 U [ % X |
A-2-|2|9 | EXEY- BN, L=
Video

Paste Embed code
Click Update
Path: p

Grabbing Your Code =]

After you have formatted your text above, press the (HTML) button located i
view your text in raw HTML code (Text Mode). Select your text by pressing (CTRT=AJ. ONCE TrTe TEXT 15 TWgNTgNTea;
copy & paste the HTML code into your application by pressing (GTRL-G) to copy and (GTRL-V) to paste.

Converting HTML to Text
To Convert HTML to normal text format, press the (HTML) button located in the upper toolbar. Paste your raw HTML
code into the text area above, then press the (HTML) button (Text Mode) to convert the HTML code back to normal

Kevboard shortcuts

@ Intemet | Protected Mode: Off “h v R100% v


http://www.youtube.com/
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Getting Ready to Build the Placemark

Select all the HTML code (Ctrl+A) and copy it (Ctrl+C). You will be pasting this within the placemark you
created in Google Earth.

Copying the HTML Code
1. Click on the HTML button in the online editor, you can see the code (below)

2. Select All (Ctrl+A) and Copy (Ctrl+C) all the HTML code in the HTML window

;@ y Information Technology Division BROOKH
o ‘ Home

BNL: Departments | Science | ESS&H | Newsroom | Administration | Visitors | Directory

Online HTML Editor (v3.0.5)

ITD Home | Online Help & Documentation

n

Note: Technical support for this application will only be available to the Brookhaven National Laboratory user community.

This online HTML WYSIWYG editor is cross-browser compatible and will work with most popular internet browsers.
Supported Browsers Include: IE, Firefox, Mozilla, SAfari, and Netscape.

Heading2 |~ Fontfamly ~ Fontsize -1 U | x x ¢

A-Z-|a|9 v ﬁ&ﬂﬁam\@w-@\mﬁ Click HTML Button

Photo

Path: h2

Grabbing Your Code

After you have formatted your text above, press the (HTML) button located in the upper toolbar to convert and
view your text in raw HTML code (Text Mode). Select your text by pressing (CTRL-A). Once the text is highlighted,
copy & paste the HTML code into your application by pressing (CTRL-C) to copy and (CTRL-V] to paste.

Converting HTML to Text
To Convert HTML to normal text format, press the (HTML) button located in the upper toolbar. Paste your raw HTML
code into the text area above, then press the (HTML) button (Text Mode) to convert the HTML code back to normal

tavt 5
€D Intemet | Protected Mode: Off orl B100% v
@ Information Technology Division, ITD - Windows Internet Explorer e =]
()~ [ htpzsvnw bl gow/ita/imiesitor ~[ &[] x ][ Googte Powered Digsty search P -
+f Favorites |33 - | @ Creating Contentin Go... | au. Information Techno.. % fii » B v [ @ v Pagev Safetyv Tooks~ @~ | bl @ &
@ | . o~
& Information Technology Division
)
D = L s
HTML Scurce Editor ¥ Word wrap

<nz>enotocsnz>

Online HTML Edil |<p><img sre="ncip://farml.scatic. flickr.com/88/258109496_465a155636_c.ipg” alt="Erie
Canal Lock” width="400" /></p>

ITD Home | Online Help || [<B><streng>Sources</strong> hrep://flicks. con/photos/sailorbill/258109486

HiHome | e e ree/o/ fec_licensec/p>

l<p>enbap;</p>

Note: Technical support fq| [h2>Video</h2>

lep>

ebject classid="clsid:d27cdbée-asdd-11ci-96b2-444553540000" width="425" height="344"

This online HTML WYSI "http://downlead. nacromedia. com/pub/ shockwave/ cabs/ flash/ awilash. cabsveraicn=

Supported Browsers I|| |6,0,40,0">

<param name="allowFallScresn” value="tzue” />

param name="allowscriptaccess” value="always™ />

Headng2 |~ Fontfamly | |<param name="src" value="http://wiw.youtube.con/v/Aak-A33zulcsanp;hl-snsanp; fa=1

m

A-%-1a2 |0 | " /»<embed type="spplication/x-shockwave-flash” width="425" height="344"

= 3rc="http:/ fwww. youtube . com/v/AaM-A33zpEcsanp; hl =ensarp; £5=1" allowfullscreen="true™
allowscriptaccess="always"></embed>
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/B>

Select All (Ctrl+A)
and Copy (Ctrl+C)

=

Path: h2

Grabbing Your Code

After you have formatted your text above, press the (HTML) button located in the upper toolbar to convert and
view your text in raw HTML code (Text Mode). Select your text by pressing (CTRL-A). Once the text is highlighted,
copy & paste the HTML code into your application by pressing (CTRL-C) to copy and (CTRL-V) to paste

Converting HTML to Text
To Convert HTML to nermal text format, press the (HTML) button located in the upper toolbar. Paste your raw HTML
code into the text area above, then press the (HTML) button (Text Mode) to convert the HTML code back to normal

tavt <

€D Internet | Protected Mode: Off v ®10% -
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Adding the HTML code to Google Earth

1. Paste the copied HTML code from the online editor into the placemark
2. Click OK, and then click on the placemark itself in Google Earth.
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You're placemark with content is now finished. Clicking on the placemark will display the content you added

in the placemark bubble (see below).
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Saving a Folder

If you are working on a Google Tour, be sure the placemark is within the folder with other placemarks for the
tour and save. Once a folder has been completed (or is still being constructed), save the folder on your
computer, to a USB drive or to a network drive.

1. Right-click on the folder, select Save Place As.

2. Choose the location where you want to save your folder (.kmz file).
3. Name the file (i.e. - yourfilename.kmz)

4. Select the .kmz file format in the Save as type field, Click OK.
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& B & Primary Database % s
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[[1== Roads
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Clge Gallery N
@ ocean ¥ : - i b Ky 3 %
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I E Places of Interest A o . . g A % M l/ '
DS More B 'y Ay ‘ EMMGOOS C

- W Terrain

i Lock:30

Eye alt 10238 mi

Saving Placemarks

After you've completed your placemark or you need to stop working, be sure to save your placemark. If your
placemarks appear in the My Places folder under the Places panel it is saved on that computer. To save a
placemark on a USB drive or network drive:

1. Right-click the placemark, select Save Place As

2. Choose the location where you want to save your placemarks file(s).
3. Name the file (i.e. - yourfilename.kml)

4. Select the.kml file format in the Save as type field, click OK
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Creating a Tour in Google Earth

Organize Your Placemarks

Follow these steps for creating a quick tour:

+ Create a new folder by clicking Add > Folder and name it so that you can identify it when adding
placemarks for the tour.

« Start adding new placemarks to be included the tour (be sure they are added to the folder you created).
TIP: You can add placemarks you already have by dragging them into the folder.

+ Once all placemarks are added to the folder, order them, top to bottom, in the sequence you would like
them to appear when someone views the tour. To do this simply click and drag them in the desired order.
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Changing Placemark Views

Adding tilt views of placemarks often gives the viewer a sense of flying from place to place and gives your tour
different dimensions other than the traditional top down view. When you add a placemark, it will default to your
current view (more accurately, what you see on your screen).

Follow these steps to change the way a placemark is viewed:

« Create or open a placemark and click the View tab

«  While still in the placemark edit mode you can use your mouse or keyboard to change the view to how
you would like it appear to those viewing the placemark.

« Once you have the view you want, click the Snapshot Current View button to set it.

& Google Earth

File Edit View Tools Add Help

¥ Search
¥ Places Add Content ‘ 3
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& Erie Canal E e Earth - Edit Placema
Source: i
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Source: Longitude: |-78.691357°
8 Locke —_
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Date/Time: None CRLIED HS
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2 GE Community

& Stream Team ) =
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Changing Tour Settings

Tours can be setup to simply fly through a set of placemarks, to get up close and personal with a Google Earth
feature or display a dramatic elevation view.

To change tour settings or options click Tools > Options to bring up the Google Earth Options window. Click
on the Touring tab to begin adjusting the settings for how tours are viewed.

When creating a tour from a folder:

Time Between Features (Placemarks)
Time Between Features is the amount of time that it takes to travel from one placemark to another. To adjust the
amount of time between placemarks, enter the number of seconds or slide the bar to the desired length of time.

Wait at Features (Placemarks)
Wait at Features is the amount of time that Google Earth will wait at each placemark. To adjust the amount of
time at placemarks, enter the number of seconds or slide the bar to the desired length of time.

| 3D View | Cache | Touring MNavigation General |

rl When creating a tour from a folder:
Time Between Features: |6.00 Seconds 0 D
Wait at Features: 5.0 Seconds or D

Fly along lines

Show balloon when waiting at features
|

MEH creaﬁng a Eur #om aline:

Camera Tilt Angle: | 19.8 Deqgrees °

Camera Range: 500.0 Meters D

Speed; 500.0 Slow

When recording a tour:

Smaller File Higher Fidelity

Restore Defaults




	Google Earth v. 5.0
	Creating Media Rich Tours
	Creating Content in Google Earth
	Working with Placemarks 
	Adding Your Content 
	Add Text 
	Adding Images 
	Adding Hyperlinks
	Adding Video Content
	Getting Ready to Build the Placemark
	Copying the HTML Code

	Adding the HTML code to Google Earth
	Saving a Folder
	Saving Placemarks

	Creating a Tour in Google Earth
	Organize Your Placemarks
	Changing Placemark Views
	Changing Tour Settings
	When creating a tour from a folder:




